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                                                  PROGRAMME SPECIFIC OUTCOMES 

 

PSO 1 
Demonstrate a comprehensive understanding of logistics, supply chain management, 

warehousing, transportation, shipping, and port operations through a blend of academic 

learning and industry-based apprenticeship exposure. 

PSO 2 
Apply theoretical knowledge to real-world logistics operations such as freight forwarding, 

inventory control, reverse logistics, and e-commerce supply chain management, thereby 

developing job-ready competencies. 

PSO 3 Effectively utilize logistics-related software, ERP systems, transport management 

systems (TMS), and data analytics tools for decision-making and process 

optimization in logistics operations. 

PSO 4 
Adapt to professional work environments by demonstrating teamwork, leadership, 

communication, and problem-solving skills acquired through structured apprenticeship 

training. 

PSO 5 
Interpret and implement shipping documentation, customs clearance, export-import 

procedures, and international trade regulations in alignment with domestic and global 

logistics frameworks. 

 

 

 



 

Credit Frame work 

NOTE: For BBA (LM) courses, the number of instructional hours shall be five (5) for courses involving problem-solving, and four (4) for courses 

comprising only theory. 

                                         

                                       

Credit Framework of  BBA(LOGISTICS MANAGEMENT)  (AEDP) with Apprenticeship from 2025-26  

 
Semester 

 
Major (4 

Cr) 

 
Minor 

/Project 

work(4/2 

Cr) 

AECC - 

Languages (3 

Cr) 

 
Multi Disny’ 

(2 Cr) 

Skill 

Enhancement 

Courses (2Cr) 

 
OOTC 

(VAC) 
IKS# 

Env. Edn* 

(2 Cr) 

 
Total 

 C H Cr C H Cr C H Cr C H Cr C H Cr C H Cr C H Cr C H Cr 

Sem 1 4 18 16 1 2 2 2 8 6    1 6(4+2) 4       8       34 28 

Sem 2 3 14 12    2 8 6 1 2 2 1 6(4+2) 4    1# 2 0 8   32 24 

Community Service Project of a minimum of 80 hours with 1 Credits.   1 

Sem 3 4 18 16    2 8 6 1 2 2 1 2 2       8 30 26 

Sem 4 6 26 24       1 2 2 1 2 2       8 30 28 

Sem 5     Apprenticeship                                                                       

Apprenticeship 

        22 

Sem 6             22 

3-YR 17  68 1  2 6  18 3  6 4  12    1+1   33  151 

Sem 7 3 12 12          2 8 8 1 2 2 1# 2 0 6 24 22 

Sem 8 3 12 12          2 8 8 1 2 2 1# 2 0 6 24 22 

4-YR 23  94 1  2 6  18 3  6 8  28 2  4    45  195 

C Courses  H Hours  Cr Credits  OOTC Open Online Transdisciplinary 

# Indian Knowledge Systems - Audit Course * Environ Edn           



 

                                        Course Structure for the A.Y. 2025-26 

 BBA Logistics Management 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Curriculum Framework of BBA Logistics Management (AEDP)      from   the 
A.Y. 2025-26  

Major +  with CSP & V and VI Semesters Apprenticeship 

                                                         1st Year - Semester I 

Sl.No Category Course No No. of Hours No. of 
Credits 

1 Fundamentals of logistics I 4 4 

2   Material Management II 4 4 
3 Warehousing and Distribution Center Operations III 4 4 
4 AECC – English I 4 3 
5 AECC - MIL (Telugu/Hindi/Sanskrit) I 4 3 

6 
Skill Enhancement Course (SEC) Intro' to 
Artificial Intelligence 

I 
4 + 
2 (Practice) 

4 

7 
Fundamentals of Accounting 

IV 
5 

4 

8 
Project Work 

V 
2 

2 

End of Semester I of 1st Year 7 33 28 

     

                                                      1st Year - Semester II 

Sl.No Category Course No No. of Hours No. of 
Credits 

1 Freight forwarding(Ocean & Air Cargo) V 4 4 

2 Forecasting and Inventory Management  VI 4 4 

3   Computerised Accounting VII 5 4 

4 AECC – English II 4 3 

5 AECC - MIL (Telugu/Hindi/Sanskrit) II 4 3 

6 Multidisciplinary Course I 2 2 

 

7 
Skill Enhancement Course (SEC) Application of 
Artificial Intelligence (Discipline Specific) 

 

II 
6(4+2)  

4 

8 Indian Knowledge System I 2 0 

9 Community Service Project (minimum of 80 hours with 1 Credits 1 

End of Semester II of 1st Year 9 32 25 



 
 
 

  

 

 

                                                                                   
                                                               2nd Year - Semester IV 
Sl.No 
 

Category 
Course 
No 

No. of 
Hours 

No. 
of 

Cre
dits 

     Theory Theory 

1 Retail Logistics & E-Commerce XII 4 4 

2 Multi-Modal transportation  XIII 4 4 

3 Import and Export Documentation   XIV 4 4 

4   In plant Logistics XV 4 4 

5   Warehouse Automation XVI 4 4 

6   Software Systems in Logistics XVII 5 4 
7 Multidisciplinary Course III 2 2 

8 
Skill Enhancement Course (SEC) Design Thinking/Problem 

Solving / Others 
IV 2 2 

End of Semester IV of 2nd Year 8 30 28 

             Curriculum Framework of BBA(Logistics Management)  (AEDP) from 
the A.Y. 2025-26  

Major +  with CSP & V and VI Semesters Apprenticeship 

2nd Year - Semester III 
Sl.No 
 

Category 
Course 
No 

No. of 
Hours 

No. 
of 

Cred
its 

1 Surface transportation VIII 4 4 

2 MIS for Logistics XI 4 4 

3 Liner Logistics X 4 4 

4   Data Analysis Using a Spread sheet XI 5 4 

5 AECC (Creative Writing/Business Writing in English) III 4 3 

6 
AECC (Creative Writing/Journalistic Writing in MIL - 
Telugu/Hindi/Sanskrit) 

III 4 3 

7 Multidisciplinary Course II 2 2 

8 
Skill Enhancement Course (SEC) Design Thinking/Problem 

Solving / Others 
III 2 2 

End of Semester III of 2nd Year 8 30 26 



 
  

  Curriculum Framework of BBA LOGISTICS MANAGEMENT  (AEDP) from the A.Y. 
2025-26  

Major +  with CSP & V and VI Semesters Apprenticeship 

3rd Year - Semester V 
  Semester 5 

S.no  Core Courses   Hours in week Credits 

1 Apprenticeship Apprenticeship   22 

  

  Semester 6 

S.no Core Courses   Hours in week Credits 

1 Apprenticeship Apprenticeship   22 

  
          



 Curriculum Framework of BBA (LOGISTICS MANAGEMENT)    (AEDP) 
from the A.Y. 2025-26  

Major +  with CSP & V and VI Semesters 
Apprenticeship 

4th Year - Semester VII 

Sl.No Category Course No No. of Hours No. of Credits 
   Theory Theory 
 Major - Core XVI 4 4 
 Major - Core XVII 4 4 

1 Major - Core XVIII 4 4 

2 Major - Elective XIX 4 4 
 Major - Elective XX 4 4 

4 OOTC I 4 2 
 IKS I 2 Audit Course 

End of Semester VI of 3rd 
Year 

7 26 22 

4th Year - Semester VIII 

Sl.No Category Course No No. of Hours No. of Credits 
   Theory Theory 

1 Major - Core XXI 4 4 

2 Major - Core XXII 4 4 

3 Major - Core XXIII 4 4 

4 Major - Elective XXIV 4 4 

5 Major - Elective XXV 4 4 

6 OOTC II 4 2 

7 IKS II 2 Audit Course 

End of Semester VI of 3rd 
Year 

7 26 22 

 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

GOVERNMENT COLLEGE (AUTONOMOUS) 
(Re-Accredited by NAAC with A + Grade) 

RAJAMAHENDRAVARAM 

BBA HONOURS (LOGISTICS MANAGEMENT) NEW 
COURSES INTRODUCED (A.Y 2025-2026) 

 

 

 

S.No Semester Course Name 

1 I Fundamentals of Accounting 

2 I Project Work 

3 II Computerized Accounting 

4 IV Import and Export Documentation   

5 IV   In plant Logistics 

6 IV   Warehouse Automation 

7 IV   Software Systems in Logistics 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) 
(Re-Accredited by NAAC with “A +” Grade) 

RAJAMAHENDRAVARAM 
Scheme of Evaluation for 

                                                            BBA (LOGISTICS MANAGEMENT)  (w. e. f 2025-
26) 

Time: 2 ½ Hours Max. Marks: 100 
 

CONTINUOUS INTERNAL ASSESSEMENT  
 
 

 
50 M 

CIA-I 20 M 

CIA-II (Online) 10 M 

Attendance 05 M 

Assignment 05 M 

Seminar/GD 05 M 

Clean and Green 05 M 

SEMESTER END EXAMS  
 

 
50 M 

 Q     M            T 

Essay 5 7 35 

Short Answers 3 3 09 

Very short Answers 6 1 06 

Total Marks 100 Marks 

Note: Q = Questions, M = Marks T=Total 

 

Note: 
1. In Very short answers 6 questions will be given, students should answer 6 questions. 

2. In Short Answers 5 questions will be given, out of those students should answer 3 
questions. 

3. In Essays 10 questions will be given from 5 units with Internal choice students should 

answer 5 questions (1 from each unit). 
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GOVERNMENT COLLEGE (AUTONOMOUS) 

RAJAMAHENDRAVARAM 

                                           (Re-Accredited by NAAC with ―A+‖ Grade) 

                                                                  DEPARTMENT OF COMMERCE 

SCHEME OF EVALUATION 

MODEL OF SEMESTER END EXAMINATION QUESTION PAPER (THEORY) 

(As Approved in the BOS meeting held on 15th September, 2025 at 11 AM) 
EVALUATION SCHEME 

Standard Operating Procedure for Continuous Internal Assessment 

(Internal Marks – 50) 

The Internal marks in all the courses/subjects will be awarded based on continuous internal 
assessment made during the semester concerned. For each Courses/subject 50 marks are 
allotted for internal assessment and 50 marks are allotted for the End Semester 
Examination. 

1. Continuous Internal Evaluation (CIA): 
It has been decided to introduce Continuous Internal assessment marks for a total of 

50 marks, which are to be distributed as follows: 

S.No. Component 
Distribution of 

Marks 

1 CIE I (after completion of 50% of syllabus) 20 

2 CIE II (Online Exam) 10 

 
 
 

 
3 

 
 
 

 
ATTENDANCE 

Above 95% 5 5 

91% to 95% 4 

86% to 90% 3 

81% to 85% 2 

75% to 80% 1 

Below 75% 0 

Pedagogical Strategies  

4 ASSIGNMENT(One Assignment from each unit) 5 

5 Participation or Paper Presentation in Student 
Seminars/Workshops/Group Discussions/ Quiz/ Student Study 
Project/Field Visit/Survey 

5 

6 Clean & Green (Maximum 3 Activities) 5 

TOTAL 50 
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Component I: CIE I & CIE II (20+10 = 30 Marks) 
Two Internal Examinations, out of which one is Mandatorily Online examination, for each 

Course shall be conducted for assessment. These examinations will be conducted during 
August/September (CIE –I) and October/November (CIE-II). CIE-I carries 20 marks and CIE-II 
carries 10 marks. CIE- I will be conducted after completion of 50% of syllabus. The second 
internal examination, i.e., CIE –II, which is mandatorily online examination will cover the 
entire syllabus.  

Suggestive Question Paper Pattern for CIE I & CIE II (Based on Blooms Taxonomy): 

Though the faculties concerned are empowered to adopt their own pattern for question 
paper, a general and suggestive model for question paper is given below based on Blooms 
Taxonomy. 

 

Q No Learning Objective Marks 

1 Memory based (Remember) 2 

2 Understand (Comprehension) 2 
3 Application 3 

4 Analysis 3 

5 Evaluation 5 

6 Creativity 5 
 TOTAL 20 marks 

The active verbs used to frame the question based on Blooms Taxonomy is given 
below for the convenience. 

BLOOM’S TAXONOMY VERBS 
REMEMBER UNDERSTAND APPLY ANALYZE EVALUATE CREATE 
Define Summarize Determine Organize Argue Design 
Memorize Compare Present Compare Defend Compose 
Repeat Describe Examine Contrast Judge Construct 
Copy Explain Implement Experiment Support Develop 
Define Discuss Solve Test Value Formulate 
State Recognize Use Question Weight Blog 
List Report Demonstrate Connect Reflect Build 
Quote Translate Interpret Deduce Review Write 
Find Categorize Re-enact Link Grade simulate 
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Co-Curricular Activities 
 

 
❖ Class discussions 

❖ Case Studies 

❖ Audio / Visual class presentations 

❖ Assignment and Project 

❖ Experimental Group Exercise 

❖ Industrial / field visits to container freight stations, ICDs, ports, warehouses (3PL providers, FMCG, e-

commerce), transport hubs, cold storage units, and rail sidings. 

❖ Guest lectures / invited talks from logistics managers, freight forwarders, customs brokers, and SCM 

consultants on practical challenges and careers. 

❖ Software/simulation-based activities: simple spreadsheet models for EOQ, reorder point, vehicle routing, 

warehouse slotting, and demand forecasting. 

❖ Logistics games and simulations. 

❖ Projects on green logistics: measuring carbon footprint of different transport modes for a typical route; 

proposing eco-friendly packaging or reverse logistics for e-waste. 

❖ Community outreach: awareness sessions on safe goods transport, road safety for truck drivers, or efficient 

last-mile delivery in local markets. 

❖ Business plan contest for a start-up in courier, warehouse, or 3PL services. 

❖ Online component: SWAYAM/NPTEL/Course, mini-courses or guided projects in supply chain, followed by 

reflection assignments and presentations. 
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       BBA(LOGISTICSMANAGENT) 

                  HONORS 

SYLLABUS AND MODEL PAPERS 

               SEMESTER -I 

                  Admitted Batch -2025-26 
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COURSE OBJECTIVES: 
• To develop competencies and knowledge of students to 

become logistics professionals 
• To orient students in the field of Logistics 
• To help Students to understand Fundamentals of Logistics 

LEARNING OUTCOMES: 
• Students will be able to apply the Basic knowledge of Logistics in 

the real-life situation 
• This subject will enable them to enhance their ability and 

professional skills in Logistics 

 
Unit Topics 

I Introduction to Logistics: 
History of Logistics Need for logistics- Cost and Productivity, cost saving & Productivity improvement. Logistics Cost, 
reduction in logistics cost, benefits of efficient Logistics, Principles of Logistics, Technology & Logistics -Informatics, 
Logistics optimization. Listing of Sub-sectors of Logistics 

II Logistics and Customer Service - Definition of Customer Service Elements of Customer Service-Phases in Customer 
Service-Customer Retention - Procurement and Outsourcing - Definition of Procurement/Outsourcing - Benefits of 
Logistics Outsourcing - Critical Issues in Logistics Outsourcing 

III Global Logistics - Global Supply Chain - Organizing for Global Logistics-Strategic Issues in Global Logistics - Forces 
driving Globalization - Modes of Transportation in Global Logistics Barriers to Global Logistics - Markets and 
Competition - Financial Issues in Logistics Performance - Integrated Logistics - Need for Integration - Activity 
Centres in Integrated Logistics. Role of 3PL&4PL. 

IV a) Warehouse: Warehouse-Meaning, Types of Warehouses Benefits of Warehousing. 
b) Transportation- Meaning; Types of Transportations, efficient transportation system and Benefits of efficient 

transportation systems. 
c) Courier/Express - Courier/Express-Meaning, Categorization of Shipments, Courier Guidelines, Pricing in 

Courier - Express Sector for international and domestic shipping. 
d) E-Commerce - Meaning, Brief on Fulfillment Centers, Reverse logistics in e-commerce sector, Marketing in 

e-commerce and future trends in e-commerce. 

V a) EXIM: Brief on EXIM/FF & CC, Multi-modal transportation, brief on customs clearance, bulk load handling and 
brief on trans-shipment. 

b) Supply chain. 
c) Cold chain. 
d) Liquid Logistics. 
e) Rail Logistics. 

Text & Reference Books: 
1. Course Material Prepared by LSC 
2. Fundamentals of Logistics Management (The Irwin/Mcgraw-Hill Series in Marketing), Douglas Lambert, James R 

Stock, Lisa M. Ellram, McGraw-hill/Irwin, First Edition, 1998. 

                                                                     Blue Print 
Unit Name of the topic Theory 

Essay 

7M 

Short 

3M 
Very short 

1M 
I UNIT-I 2 1 2 

II UNIT-II 2 1 1 
III UNIT-III 2 1 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 

FUNDAMENTALS OF LOGISTICS 

Semester 

I 
Course Type 

Domain 
Code 

L21C03 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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                                             GOVERNMENT COLLEGE (AUTONOMOUS) 

RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

(W. e. f. 2025-26 Admitted Batch) 

I BBA (LOGISTICS MANAGEMENT) – Semester – I 

                                               Course Name: FUNDAMENTALS OF LOGISTICS 

                                        Model Paper 

Time: 2 ½ Hrs                                    Max. Marks: 50 

SECTION – A 

Answer ALL the Questions:                                5×7=35 M 

1. Explain the benefits of efficient logistics.(BL 1, CO 1) 

                                                                         OR 

2. Briefly explain the principles of logistics.(BL 1, CO 1) 

3. Discuss the elements and phases in customer service.                                                             (BL2,CO2)    

                                                                  OR 

4. Explain the benefits of logistics outsourcing. (BL 1, CO 2) 

5. Enumerate the strategic issues in Global logistics. (BL 2, CO 3) 

OR 

6. Briefly explain the various modes of transportation in global logistics. (BL 2, CO 3) 

7. What are the types of warehouses, and what benefits do they provide to logistics operations?(BL2, CO 4) 

OR 

8. Discuss the concept and importance of  reverse logistics in E-Commerce. (BL2, CO 4) 

9.  Explain the role and functions of EXIM, FF and CC  in detail.                 (BL2,CO5) 

     OR 

10. Explain the terms (i) Liquid logistics (ii) Cold chain (iii) Rail logistics . (BL2, CO5) 

                                                           SECTION – B 

Answer any THREE questions.              3×3=9 M 

11. State the main factors influencing the logistics cost reduction. ( BL2,CO 1) 

12. Mention the key forces driving  globalisation in logistics. (BL 2, CO 2) 

13. Define Procurement and explain its role in logistics. (BL 2, CO 3) 

14.  What are the benefits of an efficient transportation system? (BL 4, CO 4) 

15.  Write a short on courier pricing for International and domestic shipments.(BL2, CO 5) 

                                                              SECTION - C 

Answer ALL the Questions.             6×1=6 M 

16. Define logistics Management. (BL 1, CO 1) 

17. What is meant by customer retention?(BL 1, CO 2) 

18. Name any two subsectors of logistics. (BL 1, CO 3) 

19. Define Integrated logistics. (BL 1, CO 4) 

20. Define warehousing. (BL 1, CO 4) 

21. What is meant by supply chain?  (BL 1, CO 5) 
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COURSE OBJECTIVES: 
• To help Students to understand basic Principles and 

concept of material Management 
• To orient students on contemporary development in the 

field of material management 
• To develop competencies and knowledge of students 

to become effective professionals 

LEARNING OUTCOMES: 
• To apply the knowledge about material management in the 

real-life business situation 
• Understand the contemporary practices followed in the field of 

Materials Management 
• To enhance their managerial ability and professional skills 

 

Unit Topics 

I Introduction: Materials Management - Evolution, Importance, Scope and Objectives- Interface with other 
functions. -Supply Chain Management -Objectives- Components , Trade off Customer Service & Cost. Supply 
Chain Analytics. 

II Purchasing: purchasing and procurement activities under Materials management- Purchasing Methods- Purchasing 
and quality Assurance- Purchase Cycle – governmental purchasing practices and procedures - Negotiation & 
Bargaining – Vendor relations 

III Inventory - Need of Inventory -Types of Inventory - Basic EOQ Model - EOQ with discounts – Different types of 
Analysis . 

 Forecasting –methods of forecasting-Material Requirement Planning (MRP) -Input and output of MRP system 
-BOM Explosion -MRP II. 

IV Quality control of material: Incoming material quality control- statistical quality control(Various control charts)- 
Inventory control & Cost Reduction techniques. Value Analysis & Value Engineering. Standardization – need and 
importance. Codification - concept, benefits. 

V Stores - Functions- Stores layout -documentation- Materials handling and storage systems, - Principles of Materials 
Handling system – Safety issues 

Text & Reference Books: 

1. Course Material Prepared by LSC 

2. Materials management: procedures, text and cases - A.K. Datta 

3. Materials management: An integrated approach - P. Gopalakrishnan 

4. Introduction to Materials management - J.R. Tony Arnold & Stephen N. Chapman 
 

Blue Print 
Unit Name of the topic Theory 

Essay 

7M 

Short 

3M 
Very short 

1M 

I                        UNIT-I 2 1 2 

II UNIT-II 2 1 1 
III UNIT-III 2 1 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 
 
 
 
 

MATERIALS MANAGEMENT 

Semester 

I 
Course Type 

Domain 
Code 

L21C06 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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  GOVERNMENT COLLEGE (AUTONOMOUS) 

 RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade)  

(W. e. f. 2025-26 Admitted Batch) 

I BBA (LOGISTICS) – Semester – I 

                                             Course Name: MATERIAL MANAGEMENT 

               Model Paper 

Time: 2 ½ Hrs       Max. Marks: 50 

SECTION – A 

Answer ALL the Questions:       5×7=35 M 

1. Define Material management and explain the scope and objectives of materials management. (BL 1, CO 1) 

                                                                         OR 

2. Define supply chain management. Discuss the objectives and components  of SCM 

(BL 1, CO 1) 

3. Discuss the purchasing and procurement activities under material management (BL 2, CO2) 

                                                                  OR 

4. Define purchasing. Briefly discuss about purchasing methods (BL 1, CO 2) 

5. Discuss the various types of inventory. (BL 2, CO 3) 

OR 

6. Briefly explain the steps involved in materials requirement planning. (BL 2, CO 3) 

7. Discuss the incoming material quality control techniques. (BL2 , CO 4) 

OR 

8. Explain brief note on concept to value engineering and value analysis. (BL2, CO 4) 

9. Explain the functions and importance of stores layout. (BL2,CO5) 

     OR 

10. Explain the principles of material handling system. (BL2, CO5) 

SECTION – B 

Answer any THREE questions.              3×3=9 M 

11. Importance of material management. ( BL2,CO 1) 

12. Purchase cycle. (BL 2, CO 2) 

13. Define EOQ. (BL 2, CO 3) 

14. Cost reduction techniques in inventory  (BL 4, CO 4) 

15. .Safety issues in material handling (BL 2, CO 5) 

                                                              SECTION - C 

Answer ALL the Questions.             6×1=6 M 

16. What does SCM stand for (BL 1, CO 1) 

17. Differentiate between purchasing and procurement. (BL 1, CO 2) 

18. Name any two types of inventory. (BL 1, CO 3) 

19. What does MRP stand for? (BL 1, CO 4) 

20. What is Bill of Materials (BOM) explosion? (BL 1, CO 4) 

21.  What is value analysis? (BL 1, CO 5) 
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COURSE OBJECTIVES: 
• To develop competencies and knowledge of students to 

become Warehouse professionals 
• To help Students to understand Warehousing and 

distribution centre operations 
• To orient students about contemporary practices followed 

in Warehousing & Logistics 

LEARNING OUTCOMES: 
• To apply the Basic knowledge of Warehousing and 

distribution centre operations in the real-life situation 
• To enhance their ability and professional skills 
• To Understand the contemporary Practices in the Industry 

 

Unit Topics 

I Introduction to Warehouse– Significance of Warehouses - Types of Warehouses - Broad functions in a warehouse 
- warehouse layouts - equipment requirement in ware house. Strategic Aspects of Warehousing. 

II Receiving of Goods – Advanced shipment notice (ASN)- Goods Receipt Note(GRN) -Stages involved receipt of 
goods- Visual inspection of goods unloaded - Formats for recording of goods unloaded from carriers-Procedure 
for Arranging of goods on dock -Put away of Goods- Put away list and its need - storage location codes and its 
application. 

III Procedure to Prepare Warehouse dispatches -Procedure to develop Packing list / Dispatch note- Packing- Importance 
of proper packing-Packing materials -Packing machines -Reading labels- quality parameters in packing-Significance 
of Quality parameters in packing- Cross docking method - Situations suited for application of cross docking 

IV Distribution – Definition – Significance of Physical Distribution(Need & Importance)– Channels of distribution 
-Factors affecting distribution. -Study on emerging trends in warehousing sector. 

V Warehouse Safety Rules and Procedures: The safety rules and ‘Procedures to be observed in a Warehouse - 
Hazardous cargo – Procedure for Identification of Hazardous Cargo - Instructions to handle hazardous cargo . - 
safety data sheet - Health, Safety & Environment - safety Equipment’s and their uses - 5S Concept on shop floor. 

Text & Reference Books: 
1. Course Material Prepared by LSC 

2. Definitive Guide to Warehousing, The: Managing the Storage and Handling of Materials and Products in the Supply 
Chain (Council of Supply Chain Management Professionals) 1st Edition 

3. Warehouse Management: A Complete Guide to Improving Efficiency and Minimizing Costs in the Modern Warehouse- III 
Edition-Gwynne Richards 

 

Blue Print 
Unit Name of the topic Theory 

Essay 

7M 

Short 

3M 
Very short 

1M 

I UNIT-I 2 1 2 

II UNIT-II 2 1 1 
III UNIT-III 2 1 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 

WAREHOUSING & DISTRIBUTION CENTER OPERATIONS 
OPERATIONS 

Semester 

I 
Course Type 

Domain 
Code 

L21C07 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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                   GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Accredited by NAAC “A+” Grade) 

I B.B.A LOGISTICS: Semester – I 

(For Admitted Batch 2025-2026) 

WAREHOUSING & DISTRIBUTION CENTER OPERATIONS 

MODEL PAPER 

Time: 2𝟏 /𝟐 Hrs                                                                                                   MaMarks:50M 

                                                             SECTION-A 

 

I Answer all the Questions from given below  

                                                                                                                                     5X7=35M 

1. Briefly Explain the Broad Functions of Warehousing (BL3, CO1) 

                                                                      (OR) 

2. Discuss the various types of warehouses and their roles in business operations (BL2, CO2,) 

3. Explain the procedure and documentation involved in receiving goods (BL 3, CO2,) 

                                                                       (OR) 

4. Discuss the procedures and importance of storage location planning, put-away (BL2, CO2) 

5. Explain the step-by-step procedure for preparing warehouse dispatches(BL3, CO2) 

                                                                        (OR) 

6. Discuss the significance of packing materials, packing techniques, and quality parameters in packaging. 

(BL3, CO2) 

7. Discuss the factors affecting distribution (BL4, CO2) 

                                                                      (OR) 

8. Explain the emerging trends in warehousing and distribution (BL4, CO2) 

9. Explain the various warehouse safety rules and procedures (BL5, CO3) 

                                                                      (OR) 

10.  Discuss the procedures for identification and handling of hazardous cargo(BL5,CO2) 
                                                                   

                                                                     SECTION-B 

 

II Answer any THREE Questions from the given below                                                   3X3=9M 
 

11. Explain the significance of warehousing in supply chain management. (BL2, CO1) 

12. Explain about Advanced Shipment Notice (BL2, CO2) 

13. Write about the Importance of Packing (BL2, CO2) 

14. Explain the Significance of Physical Distribution (BL2, CO4) 

15. Explain the Warehouse Safety Rules and Procedures (BL2, CO3) 
 

                                                                       SECTION-C 

 

III Answer all the Questions from the  given below                                                           6X1=6M 
 

16. Define warehousing. (BL1, CO1) 

17. What is cross-docking? (BL1, CO2) 

18. Name any two warehouse operations. (BL1, CO1) 

19. What does WMS stand for? (BL1, CO2) 

20. List two modes of transportation. (BL1, CO1) 

21. Mention one safety equipment used in warehouses (BL1, CO3) 
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 GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

                                          (Re-Accredited by NAAC with “A+” Grade)  

                                                   (W. e. f. 2025-26 Admitted Batch) 

I BBA – (Digital Marketing) – Semester – I 

Introduction to Artificial Intelligence 

                                                  Syllabus 

Hours: 04+02 Credits: 04 

Course Outcomes: Students will be able to 

CO1: Describe the different subfields and their roles in AI applications. 

CO2: Analyse the benefits and limitations of AI in diverse domains. 

CO3: Evaluate AI systems in terms of inclusivity, privacy, and robustness. CO4: 

Describe Generative AI and emerging technologies like ChatGPT. CO5: Apply 

prompt engineering concepts to various real-world use cases. 

 

Unit I: AI and its Subfields Introduction to Artificial Intelligence, History, Definition, Artificial General 

Intelligence, Industry Applications of AI, Challenges in AI. Knowledge Engineering, Machine Learning, 

Computer Vision, Natural Language Processing, Robotics. 

Unit 2: Applications of AI Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

Unit 3: Bias and Fairness in AI Systems Ethics in AI, Bias and Fairness in AI Systems, Transparency in AI 

Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, Reliability. 

Unit 4: AI in Research, Generative AI and prompt engineering AI in Experimentation and Multi- disciplinary 

research, Generative AI introduction, ChatGPT, Hugging Face, Gemini and other tools basics, Perplexity, Prompt 

engineering Definition and its importance, Role of Prompt Engineering in AI/ML Interaction, Emerging trends 

and Future Directions in AI. 

Unit 5: Applications of Prompt engineering Applications of Prompt Engineering: Education, Business & 

Commerce, Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for video, 

generating slides and slides GPT usage, Designing thumbnails and channel branding with AI 

 
Text Books: 

1. AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 

 

References: 

1. Let‟s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission. 

2. Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James Phoenix & 

Mike Taylor. 

3. Generative AI Tutorial:https://www.w3schools.com/gen_ai/ 

4. Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity & 

Creativity , For Professionals, Marketers & Entrepreneurs by Hitesh Motwani , ZebraLearn, 2025. 

 

 

http://www.w3schools.com/gen_ai/
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GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) \ (W. e. f. 

2025-26 Admitted Batch) 

                                  I BBA – (Logistics Management) – Semester – I 

                                              Introduction to Artificial Intelligence 
Practice Session 2 hrs. /week 1 
1. Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using 

/Napkin AI/ Similar Open AI tool 

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app) 

• Input sample texts (e.g., news articles, speeches). 

• Explore word frequency, keywords, sentiment. 

• Understand how NLP extracts meaning from text. 

3. Train a basic image classifier using webcam images. Observe how the model "learns." Using Google 

Teachable Machine 

• Train two image categories (e.g., “Smiling” vs. “Not Smiling”) using their own webcam images. 

• Observe how the model learns to classify. 

• Now try feeding images of people with different skin tones, facial features, etc. 

• Observe misclassifications or differences in confidence. 

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your choice. You 

may use the prompt below and also try your own. Prompt: “Act as an agriculture assistant. A farmer 

wants to know the best crop based on soil and season. Ask questions and suggest crops.” 

5. Test Generative AI- Generate a poem or image from prompt “A futuristic green city.” using 

ChatGPT, Hugging Face (e.g., image or text generation) 

6. Observe how generative AI models may show biased results when prompted with neutral profession 

descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images using the following 

neutral prompts: 

• “A doctor treating a patient” 

• “A teacher in a classroom” 

• “A CEO giving a speech” 

• “A software engineer working from home” Observe and discuss: 

• What gender/race/age are most commonly shown? 

• Are the results stereotypical or diverse? 

7. Check how language models may express bias depending on names, ethnicity, or location. Use ChatGPT 

or Gemini Prompts: Prompt A: “A person named Raj is applying for a bank loan. Will he be approved?” 

Prompt B: “A person named John is applying for a bank loan. Will he be approved?” Change names, 

genders, and nationalities. Observe the following and report your findings: 

• Are the responses different? 
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• Is one version more positive or negative? 

• Does the model express bias or hesitate? 

• Should AI make such predictions? 

            How do developers prevent this? 

8. Exploring Text Generation and Summarization with Google AI Studio Generate Creative Content 

“Write a short story (150 words) about a robot who wants to become a chef. 

• Submit and read the AI-generated story. 

• Discuss how detailed and creative the output is. Summarize a Paragraph Prompt: Summarize the 

following paragraph in 3 sentences: “Artificial Intelligence is a branch of computer science that aims 

to create intelligent machines that can mimic human thinking. It includes various subfields like 

machine learning, natural language processing, and robotics. AI is widely used in industries such as 

healthcare, finance, and transportation to improve efficiency and decision-making.” 

● Submit and review the summary. 

● Evaluate how well AI extracts key points. Refine Your Prompt Try changing the summary prompt to: 

“Summarize the paragraph above in simple language for 10-year-olds.” 

• Compare this output to the previous one. 

• Note how prompt wording changes results 

9. AI for Creative Writing Prompt: “Write a short motivational story for 10-year-old students in under 150 

words.” 

10. Generate Slides: Tool: Slides GPT/Other Free AI tool Prompt: “Create a 5-slide presentation on „AI in 

Smart Farming‟.” 

11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI Design a thumbnail using Canva‟s 

AI tools with a prompt like: “Design a YouTube thumbnail for a video titled „Top 5 AI Tools for Students‟ 
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GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) (W.e.f. 2025-26 

Admitted Batch) 

I BBA(L.M)– Semester – I Introduction to 

Artificial Intelligence Model Paper 
Time: 2 ½ Hour                                                                                            Max Marks: 50 

Section – A 
Answer any FIVE questions. 5 X 7 = 35 Marks 

1. Explain the history and evolution of Artificial Intelligence. 

(OR) 
2. Discuss the major subfields of AI and their applications in industry. 
3. Explain the role of Artificial Intelligence in healthcare and education sectors. 

(OR) 

4. Discuss the use of AI in agriculture and transportation with examples. 
5. What is bias in AI systems? Explain how fairness and transparency can be achieved. 

(OR) 
6. Discuss the importance of ethics, privacy, and accountability in AI systems. 
7. Write a detailed note on Generative AI tools such as ChatGPT, Gemini, and Hugging Face. 

(OR) 
8. Explain the role of prompt engineering in AI and ML interaction. 
9. Explain the applications of prompt engineering in education and business. 

(OR) 
10. Discuss how AI supports content creation such as creative writing and video scripting. 

 
SECTION-B 

Section – B 
Answer any Three questions. 3 X 3 = 9 Marks 
 
11. What are the main challenges faced in Artificial Intelligence? 
12. List any four AI applications in the finance or retail sector. 
13. Define inclusivity and sustainability in AI systems. 
14. What is the significance of prompt engineering? 

15. How is AI used in designing YouTube thumbnails and channel branding? 

 
SECTION-C 

 

Section – C 
Answer ALL questions. 6 X 1 = 6 Marks 
 
16. Expand AGI. 
17. Name any two subfields of AI. 
18. What is the full form of NLP? 
19. Mention one ethical concern in AI systems. 
20. Name any one Generative AI platform. 

21. Who developed the concept of Prompt Engineering? 
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                                                  FUNDAMENTALS OF ACCOUNTING 

            SYLLABUS 
Course outcomes: 

 

At the end of the course, the student will be able to 

CO1:Identify transactions and events that need to be recorded in the books of accounts.  

CO2: Develop the skill of recording financial transactions and preparing reports in accordance 

with GAAP. 

CO3:Criticallyexaminethebalancesheetsofasoletraderfordifferentaccountingperiods. 

CO4: Design New Accounting formula principles for business organisations. 

 

Unit-I-Introduction: 

Need for Accounting - Definition - Objectives - Book Keeping and Accounting- Accounting Concepts and 

Conventions-GAAP-Accounting Cycle-Classification of Accounts and its Rules-Double Entry System-

Journalizing- Posting to Ledgers, Balancing of Ledger Accounts (including Problems). 

 
Unit-II: Subsidiary Books: 

Types of Subsidiary Books-Cash Book-Three-column Cash Book-Petty Cash Book (including Problems) 

 

Unit-III: Bank Reconciliation Statement: 

Need for Bank Reconciliation-Reasons for Difference between Cash Book and Pass Book Balances-Preparation 

of Bank Reconciliation Statement (including Problems). 

 

Unit-IV: Trial Balance and Rectification of Errors: 

Preparation of Trial balance-Errors-Meaning-Types of Errors-Rectification of Errors-Suspense Account 

(including Problems) 

Unit-V:Final Accounts: 

Preparation of Final Accounts: Trading account-Profit and Loss account-Balance Sheet-Final Accounts with 

Adjustments (including Problems). 

 

References: 

1. Ranganatham G and Venkataramanaiah,Fundamentals of Accounting, Chand Publications 

2. SN Maheswari and SK Maheswari,Financial Accounting,Vikas Publications 

3.- RLGupta&VKGupta, Principles&Practice of Accounting,Sultan Chand 

&Sons 

4. S.P.Jain&K.LNarang, Accountancy-I, Kalyani Publishers 

 
Blue Print 

 

Units 

 

Name of the Topic 

Problem Theory Theory Theory 

Essay 
7M 

Essay 
7M 

Short 
3M 

Very 
Short 
1M 

1 Introduction to Accounting 1 1 2 2 

2 Subsidiary Books 1 1 1 1 

3 Bank Reconciliation Statement 1 1 1 1 

4 Trial Balance & Rectification of Errors 1 1 1 1 

5 Final Accounts 1 1 1 1 
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GOVERNMENT COLLEGE (AUTONOMOUS) 

 RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade)  

(W. e. f. 2025-26 Admitted Batch) 

I BBA (LOGISTICS) – Semester – I 

                                             Course Name: FUNDAMENTALS OF ACCOUNTING 

               Model Paper 

Time: 2 ½ Hrs       Max. Marks: 50 

SECTION – A 

Answer ALL the Questions            5×7=35 M 

1. Explain the Concepts of Accounting(BL-2,CO-1) 

                                                                         OR 

2. Prepare Journal Entries in the books of Siva from the following transactions. 
Date Particulars Amount(₹) 

01-01-2014 Siva started his business with cash         50000 

05-01-2014 Sold goods to Vignesh                              6000 

10-01-2014 Purchased goods from Vikas                  5000 

15-01-2014 Sold goods for cash                               4000 

20-01-2014 Cash received from Vignesh                    3000 

25-01-2014 Paid cash to Vikas                                        2000 

30-01-2014 Paid Salaries through cheque                      2000 

      3.  Explain the Types of Subsidiary Books (BL-2,CO-2) 

                                                                     OR  

       4.Prepare Triple Column Cash Book from the following information 

Date Particulars Amount(₹) 

1-1-2013 Commenced business 
with  Cash 

 

10,000 

  2-1-2013 Cash Sales 8000 

3-1-2013 Cash Purchases 6000 

9-1-2013 Paid in to Bank 4000 

13-1-2013 Withdrawn from bank 
for Office use 

3000 

20-1-2013 Paid for advertisements 500 

31-1-2013 Received Commission 400 

                                                       

                                                                          

5. Explain the Causes of differences between Cash book and Pass book Balances(BL-2,CO-3) 

                                                                   OR 

 

6. Prepare a Bank Reconciliation Statement of Mr. Suresh as on 31st March 2010 from the following 
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information. 

         (i) Bank balance as per Cash book                                                                        ₹24, 200 

        (ii) Cheques issued but not presented for payment                                             ₹2, 400 

        (iii)  Bank paid insurance premium Rs.1500 on customer’s behalf 

        (iv)  Cheques deposited in to bank but not collected                                           ₹2, 600 

        (v)Bank charges charged by the bank                                                                         ₹  70 

         (vi) Interest on investment collected and credited in the pass book                   ₹350 

7. Explain the different types of Errors (BL-2, CO-4) 

                                                                       OR 

      8. Prepare a Trial Balance from the following information as on 31st March 2011.   

Particulars Amount(₹) 

Drawings 2000 

General 
Expenses 

4740 

Buildings 20000 

Stock 16540 

Sales 60000 

Wages 8515 

Debtors 6280 

Creditors 2500 

Bad debts 550 

Purchases 40000 

Loan to Ravi 7880 

Bank Overdraft 40000 

Capital 10000 

          

9. Explain the difference between Trading account and Profit and loss account (BL-2,CO-5) 

                                                                        OR 

 

10. Prepare the Final accounts from the following Trial Balance.  

                                                            Trial Balance as on 31-12-2014 

Particulars                                                    Debit Amount   (₹)                     Credit Amount(₹) 

Capital                                                                                                                              37,000 

Cash in hand                                                        4,000 

Purchases, Sales                                                45,000                                                 95,000 

Returns                                                                     500                                                      600 

Wages                                                                    8,500 

Power &fuel                                                          3,500 

Salaries                                                                  6,500 

Carriage on Purchases                                        1,800   

Stock (1-1-2014)                                                    7,200 
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Buildings                                                              40,000 

Furniture                                                               5,000 

Debtors ,Creditors                                             12,000                                                          9,000 

Drawings                                                                7,600 

Total                                                                  1, 41,600                                                     1, 41,600 

Adjustments: 

1. Closing Stock (31-12-2014 )Rs. 14,000 

2. Outstanding Wages Rs.500 

3. Depreciation on Furniture 10% 

4. Provide doubtful debts on Debtors 5%     

 

 

SECTION – B 

Answer any THREE questions.              3×3=9 M 

       11.Need for Accounting ( BL-1,CO 1) 

12. Objectives of Accounting ( BL-1,CO 1) 

13. Debit Note and Credit Note(BL- 1, CO 2) 

14.  Explain any three advantages of Bank reconciliation statement(BL-2, CO-3) 

15. Meaning of Suspense Account (BL-1, CO- 4) 

                                                                                       

                                                                                         SECTION - C 
Answer ALL the Questions.             6×1=6 M 

16. Accounting Equation(BL- 1, CO- 1) 
17. Principle of Nominal Account(BL -1, CO- 1) 
18. Meaning of Contra Entry (BL 1, CO- 2) 
19. Meaning of Pass Book (BL- 1, CO- 3) 
20. Meaning of Trial Balance (BL- 1, CO 4) 
21.  Proforma of Balance Sheet(BL 1, CO 5) 
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BBA-Logistics Management 

Syllabus & Model Papers 
Semester – II 

Admitted Batch 2025-26 
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COURSE OBJECTIVES: 

• To develop competencies and knowledge of students to 
become freight forwarding professionals 

• To develop competencies on documentation procedures 

• To help Students to understand freight forwarding. 

LEARNING OUTCOMES: 

• Students will be able to apply the Basic knowledge of freight 
forwarding including ocean and air cargo in the real-life 
situation 

• Students will be able to demonstrate their skill on 
documentation in their profession. 

• This subject will enable them to enhance their ability and 
professional skills.

 
 

 
Unit Topics 

I Introduction to EXIM, Freight forwarding and custom clearance – types of custom clearances 

 – Importance of custom clearance – certificate of origin, ICEGATE and insurance – custom Act – Regulations 
pertaining to custom clearance – different modes of freight forwarding –– process of freight forwarding. 

II Multimodal transportation - Vendor management - bulk load handling - brief on transhipment - DG handling - 
customer acquisition and management - Customs clearance procedure - Documents and its importance - Stages 
of Documentations process and procedures - - DO’s and DON’T’s while handling different documents during 
Custom Clearance 

III Operation Procedures of Freight Forwarding - The procedures for Pre-Operating Checks and Operational checks 
to be performed for every shipment /consignment - List of basic handling of errors and the Operational errors 
that occur in common - Procedure for checking of shipping bill, Airway bill based on invoice and packing list 
received from department for Freight Forwarding. 

IV Cargo handling, INCO terms and terminologies used in Cargoes - Different Types of Cargoes for transportation– 
Importer and exporter Code (IEC), The registered PAN based Business Identification Number received from the 
Directorate General of Foreign Trade - Packaging requirement for the cargo during shipment from the shipper 
- Inspection procedure for the cargo while unloading - DO’s and DON’T’s while handling different cargo. 

V Documentation of Freight Forwarding process as per customer timelines and requirements - Carting, unloading, 
Stacking, Loading; and Stuffing - Procedure for dealing with loss or damage to goods - Different P.G.A and their 
roles. -Containers; Pallets; Palletization; Fumigation - Letters of Credit and payment Terms. Etc. - computer and 
its application in internal systems of documentation. 

Text & Reference Books: 
1. Course Material Prepared by LSC 
2. J P Saxena, Warehouse Management and Inventory Control- Vikas Publication House Pvt Ltd, First Edition, 2003. 

 

 

 

 

FREIGHT FORWARDING (OCEAN & AIR CARGO) 

Semester 

II 
Course Type 

Domain 
Code 

L21C10 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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Blue Print 
Unit Name of the topic Theory 

Essay 

7M 

Short 

3M 
Very short 

1M 

I UNIT-I 2 1 2 

II UNIT-II 2 1 1 
III UNIT-III 2 1 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 
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                       GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Accredited by NAAC “A+” Grade) 

I B.B.A LOGISTICS: Semester – I 

(For Admitted Batch 2025-2026) 

FREIGHT FORWARDING(OCEAN AND AIR CARGO) 

MODEL PAPER 

Time: 2𝟏 /𝟐 Hrs                                                                                                   MaMarks:50M 

                                                             SECTION-A 

 

I Answer all the Questions from given below  

                                                                                                                                     5X7=35M 

1. Explain the various types of custom clearances and their procedures in EXIM operations.(BL2, COI) 

                                                               (OR) 

 

2. Discuss the importance of custom clearance in international trade with suitable examples.(BL2, CO1) 

3. Describe the Certificate of Origin, ICEGATE, and Insurance in detail and their importance in export-import 

processes. 

                                                                (OR) 

4.  Explain the Customs Act and regulations pertaining to custom clearance and their relevance in export-

import documentation. (BL2, CO2,) 

5. Discuss the different modes of freight forwarding and explain the process of freight forwarding.(BL 3, 

CO2,) 

                                                    (OR) 

6. Write a detailed note on Multimodal transportation and its advantages in international logistics. 

(BL2, CO2) 

7. Explain the customs clearance procedure and list the important documents required during the process 

(BL3, CO2) 

                                                                        (OR) 

8.  Describe the stages of documentation process and procedures and mention the Do’s and Don’ts while 

handling different documents during customs clearance.((BL3, CO3) 

9. Discuss the operation procedures of freight forwarding including pre-operational and operational 

checks(BL3, CO3) 

                                                                      (OR) 

10. Explain the handling of cargo during shipping and unloading, highlighting DG cargo handling, packaging 

requirements, and inspection procedures.(BL3, CO3) 

                                                                   SECTION-B 

II Answer any THREE Questions from the given below                                                   3X3=9M 
 

11. What is the role of custom clearance in EXIM business? (BL2, CO1) 

12. Write a short note on ICEGATE and its significance. (BL2, CO2) 

13. What is multimodal transportation and how does it benefit freight forwarders? (BL2, CO2) 

14. List any three important documents used in the customs clearance process. (BL2, CO3) 

15. Mention three common operational errors that occur in freight forwarding activities. (BL2, CO3)   
                                                 SECTION-C                                  

III Answer all the Questions from the  given below                                                           6X1=6M 

16. Define warehousing. (BL1, CO1) 

17. What is cross-docking? (BL1, CO2) 

18. Name any two warehouse operations. (BL1, CO1) 

19. What does WMS stand for? (BL1, CO2) 

20. List two modes of transportation. (BL1, CO1) 

21. Mention one safety equipment used in warehouses (BL1, CO3) 
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COURSE OBJECTIVES: 

• To develop competencies and knowledge of students to 
become Forecasting and inventory management 
professionals 

• To orient students in the field of Forecasting and 
inventory management 

• To help Students to understand forecasting and 
inventory management 

LEARNING OUTCOMES: 

• Students will be able to apply the Basic knowledge of 
forecasting and inventory management in the real life 
situation 

• It will enable them to enhance their ability and professional skills 
in inventory managemen

Unit Topics 

I Forecasting: Meaning –Need -Types of forecasts –Demand Forecasting- Types of Demand Forecasting- 

 -Importance - Demand planning v/s Forecasting-Sources of demand-Supply chain dynamics 

II Sales and Operations Planning- Goals and objectives of S&OP -Collaborative Planning-Types 

 -Collaborative planning, forecasting and replenishment- Cyclic decomposition techniques. Short- term forecasting 
techniques- Technology Forecasting and Methodologies: Role of Technology Information Forecasting and 
Assessment Council (TIFAC). 

III Inventory: Purpose of Inventory- -Types of Goods -General Management of Inventory- Multi-Echelon Inventory 
Systems -Use of Computers in Inventory Management- Evaluation of Performance of Materials Function–Latest 
trends in Inventory Management 

IV Codification – Classification – Methodology–Requirement of codes – Coding Structure and Design 

 –Advantages - International Codification – Right Quantity – Economic Ordering Quantity -Costs associated with 
Inventories- Models in logistics 

V Influence of production policy on inventory levels – inventories and customer service level – steps to improve 
inventory management – optimum inventory –Inventory management uncertainty (fixed order quantity model) - 
Calculation of safety stocks 

Text & Reference Books: 

1. Course Material Prepared by LSC 

2. Sunil Chopra and Peter Meindl, Supply Chain Management Pearson Education Asia, 3rd edition, 2007 

3. Chaman L Jain, “Fundamentals of Demand Planning & Forecasting”, Graceway Publishing Company 3rd edition. 

Blue Print 
Unit Name of the topic Theory 

Essay 
7M 

Short 
3M 

Very short 
1M 

I UNIT-I 2 1 2 

II UNIT-II 2 1 1 

III UNIT-III 2 1 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 

FORECASTING AND INVENTORY MANAGEMENT 

Semester 

II 
Course Type 

Domain 
Code 

L21C11 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

                                             (Re-Accredited by NAAC with “A+” Grade)  

                                                         (W.e.f. 2025-26 Admitted Batch) 

I BBA(L.M)– Semester – I  

Forecasting and Inventory Management 

Model Paper 
Time: 2 ½ Hour                                                                                            Max Marks: 50 

Section – A 
Answer any FIVE questions. 5 X 7 = 35 Marks 

1. Explain the meaning, need, and importance of forecasting in supply chain management.(BL2, CO1) 

                                                                (OR) 

2. Discuss the types of forecasts and the role of demand forecasting in business decision-making.(BL2,CO1) 

3. Describe the types of demand forecasting and explain their importance in inventory and supply chain 
decisions. (BL2, CO1) 

                                                                (OR) 
4. Differentiate between demand planning and forecasting. Explain the sources of demand and supply chain 

dynamics.(BL2, CO1) 
5. Explain the goals and objectives of Sales and Operations Planning (S&OP) in supply chain 

management.(BL2, CO1) 
                                                               (OR) 

6. Write a detailed note on Collaborative Planning, Forecasting and Replenishment (CPFR) and explain cyclic 
decomposition techniques.(BL2, CO2) 

7. Discuss the short-term forecasting techniques and their applications in business.(BL3, CO2) 
                                                                       (OR) 

8. Explain the role of Technology Information Forecasting and Assessment Council (TIFAC) in promoting 
technology forecasting and development in India..(BL3, CO2) 

9. Discuss the purpose of inventory, types of goods, and general management of inventory in supply 
chains..(BL3, CO2) 

                                                                  (OR) 
10. Explain the concept of codification, its methodology, advantages, and international codification 

systems..(BL3, CO2) 
 
                                                    SECTION-B 

Section – B 
Answer any Three questions. 3 X 3 = 9 Marks 

11. What are the main objectives of forecasting in logistics and supply chain? .(BL2, CO1) 
12. State the differences between demand planning and forecasting .(BL3, CO1) 
13. What are the benefits of collaborative planning in supply chain operations?.(BL2, CO2) 
14. Briefly explain the importance of technology forecasting.(BL2, CO2) 
15. What are the different types of inventories maintained by organizations?.(BL2, CO2) 

 

 

                                                 SECTION-C 

Section – C                                Answer ALL questions.                                                                        6 X 1 = 6 Marks 

16. What is demand forecasting? (BL1, CO1) 
17. Expand S&OP.(BL1, CO1) 
18. What does TIFAC stand for?(BL1, CO1) 
19. What is meant by Economic Ordering Quantity (EOQ)?(BL1, CO1) 
20. Define safety stock.(BL1, CO1) 
21. Mention one latest trend in inventory management.(BL1, CO1) 
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GOVERNMENT COLLEGE (AUTONOMOUS) 

RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

I BBA(LOGISTICS MANAGEMENT) - 

Semester -II 

COMPUTERISED  ACCOUNTING 

            (W.e.f 2025-2026admitted batch) 

SYLLABUS 

Hours – 5 (Teaching – 4, Tutorial – 1), Credits: 4 
Course Outcomes :  

1. Students will be proficient in using popular accounting software, such as Tally or QuickBooks. 

2. Students will be able to prepare accurate financial statements, including balance sheets and income statements, using 

accounting software. 

3.Students will learn to analyze financial data and generate reports using accounting software. 

4. Students will understand how to implement and maintain computerized accounting systems. 

5. Students will apply theoretical accounting concepts to real-world scenarios using accounting software. 

 

Unit-1:Introduction 

Microsoft Excel Spread Sheet- Functions in Excel- Preparation of Accounts, Statements and Budgets 

using MS Excel-Analysis and Interpretation. 

Unit-II: Introduction to Leading Accounting Software -Busy-Marg–QuickBooks-Zoho Books- 

Tally-Features and Accounting. 

Unit-III: Tally ERP-9-Company Creation-Tally Startup Screen-Gateway of Tally- Create 

Company-Alter & Delete company-Backup and Restore- Security Features in Tally. 

Unit-IV: Tally-Accounting Masters-Groups-Create Ledgers-Alter & Delete-Inventory Masters- 

CreatingStock Groups –Stock Items-Unit of Measurement-Alter &Delete. 

Unit-V: Tally-Voucher Entry-Vouchers Types -Vouchers Entry- Alter and deleting Settings 

PurchaseVouchers and Sales Vouchers including Tax component–Reports Generation. 

 

References 

1. Nadhani,AshokK, Tally ERP 9TrainingGuide,BPBPublications 

2. Tally9 in Simple Steps, Kogent Solutions Inc.,John Wiley &Sons. 

3. Tally9.0 (English Edition), (Googlee Book)Computer World 

4. Tally.ERP 9 Made Simple Basic Financial Accounting by BPB Publisher. 

 

Blue Print 
Unit Name of the topic Theory 

Essay 

7M 

Short 

3M 
Very short 

1M 

I UNIT-I 2 1 2 

II UNIT-II 2 1 1 
III UNIT-III 2 1 1 
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IV UNIT-IV 2 1 1 

V UNIT-V 2 1 1 
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GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

                                             (Re-Accredited by NAAC with “A+” Grade)  

                                                         (W.e.f. 2025-26 Admitted Batch) 

I BBA(L.M)– Semester – II 

Computerised Accounting 

Model Paper 
Time: 2 ½ Hour                                                                                            Max Marks: 50 

Section – A 
Answer any FIVE questions. 5 X 7 = 35 Marks 

1. Explain the various functions available in MS Excel with suitable examples. (BL3, CO1) 

                                                                (OR) 

2. Discuss how MS Excel can be used for preparation of financial statements and budgets(BL2,CO1) 

3. Compare the features of Busy, Marg, QuickBooks, Zoho Books, and Tally.. (BL3, CO2) 
                                                                (OR) 

4. Explain how accounting is performed using any two popular accounting software packages.. (BL3, CO2) 

5. Describe the process of company creation in Tally ERP-9. (BL3, CO3) 
                                                               (OR) 

6. Explain the backup, restore, and security features available in Tally ERP-9.(BL3, CO3) 

7. Explain the process of creating and altering Accounting Masters in Tally. (BL3, CO4) 
                                                                       (OR) 

8. Describe the steps involved in creating and managing Inventory Masters such as Stock Groups, Stock 

Items, and Units of Measurement.(BL3, CO4) 

9. Explain the different types of vouchers available in Tally ERP-9 and their uses.(BL3, CO5) 
                                                                  (OR) 

10. Discuss how purchase and sales vouchers are entered with tax components in Tally. (BL3, CO5) 
 
                                                    SECTION-B 

Section – B 
Answer any Three questions. 3 X 3 = 9 Marks 

11. What are the main components of an Excel spreadsheet?. (BL2, CO1) 

12. List any three advantages of using accounting software.. (BL2, CO2) 

13. What are the steps to alter or delete a company in Tally ERP-9? (BL2, CO3) 

14. Define “Stock Item” and “Stock Group” in Tally. (BL2, CO4) 

15. What types of reports can be generated using Tally ERP-9? (BL2, CO5) 
 

 

                                                 SECTION-C 

Section – C                                Answer ALL questions.                                                                        6 X 1 = 6 Marks 

16. What is a spreadsheet? (BL1, CO1) 

17. Name any two functions used in MS Excel. (BL1, CO1) 

18. Expand ERP.. (BL1, CO2) 

19. Name any two accounting software other than Tally.. (BL1, CO3) 

20. What is a Ledger in Tally?. (BL1, CO4) 

21. What is a Voucher? . (BL1, CO5) 
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 GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) \ (W. e. f. 

2025-26 Admitted Batch) 

I BBA – (Logistics Management) – Semester – II 

                                                SEC- APPLICATIONS OF AI 

Theory Credits: 3 4 hrs/week 

 

 

Course Objectives: 

1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms relevant to 

commerce and management. 

2. Familiarize students with different types of datasets and public repositories used in AI research. 

3. Develop skills in building AI data pipelines through collection, annotation, cleaning, and 

preprocessing. 

4. Understand how AI enhances retail and e-commerce and explore personalization, recommendation 

systems, and customer engagement 

5. Apply AI to streamline business processes and decision-making and explore AI in finance, HR, and 
supply chain management 

Course Outcomes: On successful completion of this course, students will be able to: 

1. Explain the AI ecosystem (hardware, cloud, and edge devices) and its relevance to commerce and 

management. 

2. Differentiate between structured and unstructured data, and utilize public datasets for business- 

oriented AI applications. 

3. Design a conceptual AI data pipeline for solving real-world problems in commerce and 

management. 4. Understand and apply AI technologies to improve customer engagement and 
personalization in commerce. 

5. Use AI tools to streamline business operations, enhance decision-making, and detect patterns in data. 

Unit 1: 

Infrastructure and Platforms for Building Applications using AI Hardware used in building AI 

applications: Processors - CPU, GPU, TPU, NPU, Memory - RAM, VRAM, Storage - HDD, SSD 

Platforms for building applications using AI: Online platforms (Example - Google AutoML, H2O.ai, 
Teachable Machine or similar platforms - for practice only); Desktop (No-code/Lowcode) platforms 

(Orange Data Mining, KNIME, Weka, RapidMiner or similar tools - for practice only). Edge AI: Concept; 
Applications in daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, Micro Ovens, 

Smart Cars/Scooters; Edge AI in smart Appliances 

Unit 2: 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI Importance of data in 

building AI applications: Data as the fuel for AI, Role of big data in training AI models. Conceptual 

Foundations of Data: Data vs. Information vs. Knowledge. Structure of Data: Structured, Semi- Structured, 
and Unstructured Data. Modalities of Data: Text, Image, Audio, Video, Tabular, Time- Series, and Spatial 

Data. Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), Audio/Video 
(MP3, WAV, MP4, AVI). Data Repositories: Definition of public Datasets; Definition of private Datasets; 

Importance of Public Datasets, Popular Public Dataset Repositories (Example - Kaggle, Hugging Face 
Datasets, UCI Machine Learning Repository, Google Dataset Search or similar ones - for demonstration 

only), Dataset licensing and usage rights. Ethics, Privacy in Data Usage: Privacy concerns related to data 
usage; Regulations governing data usage - GDPR, HIPAA (Overview), Ethical use of data, Responsible AI 

data practices. 
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Unit 3: 

The AI Data Pipeline: From Collection to Model Readiness The AI Data Pipeline: Stages and Components: 

Key Stages (Data Collection, Annotation, Preprocessing, Splitting, Feeding into AI 

Models Core Components: Ingestion, Storage, Processing, Validation, Delivery Data Collection Methods 

for AI: Manual Input (Surveys, forms, human-curated entries), Sensors & IoT Devices (Real- time data from 
physical environments), System Logs & Transactions, Web Scraping (Automated extraction from websites), 

APIs (Structured data access from external platforms) Data Annotation and Labelling: Definition & 
Importance; Annotation Methods: Manual Annotation, Automated Annotation; Types of Annotation: 

Classification, Bounding Boxes, Segmentation, Transcription, Named Entity Recognition (NER) Data 
Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: Missing Values, 

Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: Identify Issues, Handle Errors 

(Imputation, Removal), Validate Cleaned Data Data Splitting: Splitting data into training set and test set. 
Data Transformation Techniques: Normalization, Transformation, Feature Engineering (Conceptual). 

Unit 4: 

AI in Commerce – Transforming the Consumer Experience Introduction to AI in Commerce, 

Recommendation Engines (Collaborative & Content-Based), Chatbots and Virtual Assistants, Sentiment 

Analysis and Review Mining, Inventory Optimization and Demand Forecasting, Ethical Issues related to 
use of AI in Commerce and Business: Bias, Privacy, and Transparency 

Unit 5: 

AI in Business Operations – Driving Efficiency and Insight AI in Business Intelligence and Predictive 
Analytics, Financial Applications: Fraud Detection, Risk Modelling, HR Applications: Resume Screening, 

Employee Analytics, Supply Chain Automation and Optimization, AI in Marketing: Customer 

Segmentation, Lead Scoring, Strategic Adoption of AI in Enterprises, Explainable AI in E- Commerce. 
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  GOVERNMENT COLLEGE (AUTONOMOUS),  RAJAMAHENDRAVARAM 

                                            (Re-Accredited by NAAC with “A+” Grade)  

                                                      (W. e. f. 2025-26 Admitted Batch) 

                                  I BBA – (Logistics Management) – Semester – II 

SEC- APPLICATIONS OF AI 

Theory Credits: 1 2 hrs./week 

Suggested Lab Practicals (No Coding) 

Lab 1 - Exploring Public Datasets (Orange Data Mining) 

● Visit a public repository (Kaggle, UCI, data.gov.in) 

● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 

● Procedure: 

1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 

2. Connect to Data Table → View rows/columns. 

3. Connect to Data Info → Check attributes, data types. 

4. View in Data Table and Distributions widget. 

● Observation: Note numeric, categorical, missing values. 

● Outcome: Students understand structured data format in CSV. 

Lab 2 - Understanding Dataset Metadata and Formats 

● Take two datasets in different formats (CSV, JSON) 

● View metadata (description, features, size, license) 

● Compare domain-specific datasets (e.g., medical vs. finance) 

Lab 3 - Data Annotation Exercise 

● Use MakeSense.ai or VGG Image Annotator (VIA) 

● Annotate 10 sample images (traffic signs, fruits, or medical scans) 

● Export annotations in XML or YOLO format 

● Discuss annotation errors and challenges 

Lab 4 - Data Cleaning and Visualization (Orange Data Mining) 

● Aim: To clean dirty data and visualize categorical and numeric attributes. 

● Procedure: 

1. Load dataset. 

2. Connect File → Edit Domain (to change types) and Impute (to fill missing values). 

3. Compare cleaned vs. original in Data Table. 

4. Distributions widget. 

5. Check various features distribution. (Optional: Create simple bar charts/line charts to visualize 

trends using Google Looker Studio) 

● Observation: Missing values filled with mean/median., Graphical representation of data. ● Outcome: 

Learn importance of data cleaning., Students learn importance of visualization in preprocessing. 

Lab 5: Train/Test Split in Orange 

● Aim: To split dataset for AI training/testing. 

● Procedure: 1. Load Titanic dataset. 

2. Connect File → Data Sampler (70% train, 30% test). 
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3. Connect outputs to Data Table widgets to view. 

● Observation: Students see two different subsets. 

Outcome: Concept of model validation using split data. 

Lab 6: Introduction to AI in Commerce – Use Case Exploration 

Prerequisite: Discuss conceptually about Clustering 

Objective: Understand how AI is applied in commerce through data visualization and clustering. Orange 

Workflow: Use Orange Data Mining Tool 

Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering 

Dataset: Retail customer data (e.g., purchase frequency, amount spent) Dataset 

Link: Retail Sales Data 

Activities: · 

Load customer data and visualize spending patterns. · Apply 

clustering to identify customer segments. · 

Discuss how businesses can tailor services to each segment. 

Outcome: Students grasp how AI helps businesses understand and target consumers more effectively. 

Lab 7: Recommendation Engine Simulation 

Prerequisite: Discuss conceptually about Clustering 

Objective: Simulate collaborative filtering using similarity-based clustering. 

Orange Workflow: Widgets Used: File → Distance → Hierarchical Clustering → Data Table Dataset: 

User-product ratings matrix 

Dataset Link: Amazon Product Recommendation System 

Activities: 

● Calculate similarity between users. 

● Group similar users and recommend products based on cluster behavior. 

● Discuss differences between collaborative and content-based filtering. Outcome: Students 

understand the logic behind recommendation systems and how they personalize user experience. 

Lab 8: Chabot Intent Classification 

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression 

Objective: Train a model to classify customer queries into intents. 

Orange Workflow: Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression 

→ Test & Score Dataset: Sample customer queries labeled with intents (e.g., “track order”, “return 

item”) Dataset Link: Customer Intent Classification 

Activities: 

● Preprocess and victories text data. 

● Train a classifier to predict query intent. 

● Evaluate accuracy and discuss chatbot training. 

Outcome: Students learn how AI understands and responds to customer queries. 

Lab 9: Sentiment Analysis of Reviews 

Prerequisite: Discuss conceptually about Naive Bayes Objective: 

Classify customer reviews as positive or negative. 

Orange Workflow: Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & 

Score Dataset: Product reviews with sentiment labels 

Dataset Link: Amazon Product Reviews – Sentiment Analysis 
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Activities: ● Clean and tokenize review text. ● Train a sentiment classifier. ● Visualize word clouds for 
positive vs. negative reviews. Outcome: Students analyze customer feedback and extract actionable 

insights. 

 

Lab 10: Demand Forecasting with Regression 

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression 

Objective: Predict future sales using regression models. 

Orange Workflow: Widgets Used: File → Linear Regression → Scatter Plot → Test & Score Dataset: Historical 

sales data (e.g., monthly sales, promotions) 

Dataset Link: Comprehensive Retail Sales Data 

Activities: ● Train a regression model to forecast sales. ● Visualize predictions vs. actuals. ● Discuss 

implications for inventory planning. 

Outcome: Students understand how AI supports demand forecasting and inventory control. 

Lab 11: Bias Detection in AI Models 

Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion Matrix Objective: 

Explore bias in predictive models and its impact. 

Orange Workflow: Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions 

Dataset: HR hiring data with gender or age attributes 

Dataset Link: HR Data Analytics 

Activities: ● Train a model to predict hiring decisions. ● Analyze performance across demographic 
groups. ● Discuss fairness, transparency, and ethical implications. 

Outcome: Students critically assess bias and propose ethical safeguards. 

Lab 12: Predictive Analytics for Business Intelligence 

Prerequisite: Discuss conceptually about Random Forest 

Objective: Use classification to predict customer churn. 

Orange Workflow: Widgets Used: File → Random Forest → Test & Score → ROC Analysis Dataset: 

Telecom or subscription data with churn labels 

Dataset Link: Telco Customer Churn – IBM Dataset 

Activities: ● Train and evaluate a churn prediction model. ● Interpret ROC curves and accuracy. ● 

Discuss how businesses can act on predictions. 

Outcome: Students apply predictive analytics to improve customer retention. Lab 

13: AI in HR and Marketing – Resume Screening & Segmentation 

Prerequisite: Discuss conceptually about Clustering 

Objective: Classify resumes and segment customers using clustering. 

Orange Workflow: HR Task: File → Preprocess Text → Bag of Words → Logistic Regression 

Marketing Task: File → k-Means Clustering → Scatter Plot Resume Screening 

Dataset: Employee Hiring Data Customer Segmentation Dataset: Customer Segmentation Dataset 
Activities: ● Screen resumes based on job fit. ● Segment customers by behavior or demographics. ● 

Discuss automation benefits and risks. 

Outcome: Students explore how AI enhances HR and marketing efficiency. 

Books/References 

1. Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 

and visualization without coding) 

2. AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real- 

world use cases) 
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3. Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 

quality, preprocessing, and pipelines) 

4. Hands-On Data Science for Non-Programmers, David Meerman Scott (Spreadsheet-based data 

exploration and visualization) 

5. You Look Like a Thing and I Love You – Janelle Shane 
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                               GOVERNMENT COLLEGE (AUTONOMOUS),         

                                                      RAJAMAHENDRAVARAM 

                                 I BBA (Logistics Management) – Semester II  

SEC: APPLICATION OF AI 

Model Paper 
Max Marks: 50 Time: 2½ Hours 

SECTION – A  
 
Answer any FIVE questions. (Each question carries 7 marks)      (7x5=35 Marks) 
 
1. Explain various hardware components used in building AI applications. 

(OR) 
2. Discuss Edge AI and its applications in smart appliances. 
3. Describe the types and formats of data used in AI applications. 

(OR) 
4. Explain the importance of public datasets and their ethical usage. 

 

5. Illustrate the stages involved in the AI data pipeline with examples. 
(OR) 

6. Explain data cleaning and preprocessing techniques in AI. 

 

7. Discuss the role of chatbots and recommendation engines in transforming commerce. 
(OR) 

8. Explain ethical issues related to AI in business such as bias, privacy, and transparency. 

 

9. Describe how AI is used in HR analytics and supply chain optimization. 
(OR) 

10. Explain the concept of Explainable AI and its importance in business operations. 

 
SECTION – B  
                                             

Answer any Three question. (Each question carries 3 marks)     (3x3=9 Marks) 
11. Write a short note on online and desktop platforms for AI application development. 
12. Differentiate between structured and unstructured data with examples. 
13. What are the key components of data annotation? 
14. Write a short note on sentiment analysis and review mining. 
15. Briefly explain AI in financial applications. 

 
SECTION – C 

Answer All questions. (Each question carries 1 mark)      (6x1=6 Marks) 
16. Expand the term TPU. 
17. Name any one public dataset repository. 
18. What is “Dirty Data”? 
19. Mention one example of Edge AI in daily life. 
20. What does GDPR stand for? 

21. Define Explainable AI. 

 

 

 

 

 



 

44 

 

 

 

    

 

 

 

BBA-Logistics Management 

Syllabus 
Semester – III 

Admitted Batch 2025-26 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

45 

 

 

 

 

 

 

 

                                        
 

 
 

 

COURSE OBJECTIVES: 

1. To help Students to understand basics of surface 
transportation including road and rail transport 

2. To develop competencies and knowledge of students to 
become transportation professionals 

LEARNING OUTCOMES: 

3. Students will be able to apply the knowledge of surface 
transportation in the real-life situation 

4. Enhancement of professional skills with regard to the field. 

 

 
Unit Topics 

I Introduction to surface transportation -Need - functions of transportations in logistics -Types of transportations 
metrics -various land transport carriers and their Load capacities - types of temperature-controlled carriers- inter 
modal transport -verification of carriers and drivers -transit rules 

II Transportation Optimisation -Documentation for transportation – GST – E Waybill Filing - Importance of 
consignment number -Transportation Telematics -Vehicle tracking system - GPS systems 

 -Procedure for downloading and reading tracking data from devices -Probable reasons for delay or any issues 
during transit -Solutions - re-routing 

III Organisation structure in a Transport organization- Incident management systems & Processes - hazmat goods 
rules -Importance of safety data sheet and labels -Procedure for Consolidation of consignments for optimal loads 
-Reporting discrepancies such as pilferages, loss or damage of goods in transit -Checking insurance and claims 
-steps to close deliveries. 

IV Benefits of efficient transportation systems-emerging trends in transportation sector-pricing in transportation 
sector-govt regulations on transportation in India. Safety procedures during transit and emergency response 
steps - List of good practices in driving. 

V Customer Management-Vendor coordination for return truck loads-DG Handling – features and facilities offered 
by railways – innovative schemes-facilities to popularize rail logistics in India 

Text & Reference Books: 

a. Course Material Prepared by LSC 

b. J P Saxena, Warehouse Management and Inventory Control-Vikas Publication House Pvt Ltd, First Edition, 2003. 

c. A Practical Guide to Logistics: An Introduction to Transport, Warehousing, Trade and Distribution -Jerry Rudd-Kogan 
Page publications 

 

SURFACE TRANSPORTATION 

Semester 

II 
Course Type 

Domain 
Code 

L21C12 
Hours 

60 
Credits 

4 
Version 

2025-26 
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COURSE OBJECTIVES:   

➢ To develop competencies and knowledge of students to 
become MIS for logistics professionals. 

➢ To orient students in the field of logistics. 

➢ To help students to understand MIS for logistics. 

LEARNING OUTCOMES: 

• Students will be able to apply the basic 
knowledge of MIS for logistics in the real life  

Situations. 

                                                                                

 
Unit Topics 

I Introduction- IT and management opportunities and challenges-Strategic planning and models - Information 
management & IT Architecture – IT Architecture & infrastructure, cloud computing and services, Virtualization 
and Virtual Machines. 

II Database Technology- Data warehouse- Data Mart Technologies- Data and Text mining- Business Intelligence 
& Analytics, Digital and physical document management. Networks, collaboration & sustainability: Business 
IT networks & components, communication technologies – Sustainability and Ethical issues - Internal control- 
Business Control and Auditing. 

III Dissemination of technology information- and strategic planning – Technology choice and evaluation methods – 
Analysis of alternative technologies – Implementing technology programmes - Intellectual Capital - An introduction 
to Intellectual Property Right - Patent -Copyrights - Trademarks and other issues. 

IV Functional Area & Compliance systems: Management levels and functional systems Enterprise Systems and 
applications: Enterprise systems, Enterprise Resource Planning (ERP), Supply Chain Management (SCM), 
Collaborative Planning, Forecasting, and Replenishment system (CPFR), Customer Relationship Management 
(CRM). Performance Management: Data visualization, Mashups, and Mobile intelligence, Fleet Management 
Information System. 

V Business Process and Project Management: - Architecture & IT design, System development, Software & 
Applications for management (Business software tools), Support system. ERP modules 
-sales and Marketing, Accounting, Finance, Materials and Production management etc. 

Text & Reference Books: 
1. Course Material Prepared by LSC 

2. KENNETH C. L., JANE P. L., & RAJANISH DASS (2001) Management Information System - Managing the Digital Firm. 
Pearson Education: New Delhi. 

 
 

MIS FOR LOGISTICS 

Semester 

III 
Course Type 

Domain 
Code 

L21C15 
Hours 

60 
Credits 

4 
W.E.F 

2025-26 
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COURSE OBJECTIVES: 

• To develop competencies and knowledge of students to 
Liner logistics professionals 

• To orient students in the field of Logistics 

• To help Students to understand Liner logistics 

LEARNING OUTCOMES: 

• Students will be able to apply the Basic knowledge of Liner 
Logistics in the real-life situation 

• This subject will enable them to enhance their ability and 
professional skills in Logistics. 

 
Unit Topics 

I Definitions of liner trades; tramp trades; containerization- Unitization - containerization, liner operations, port 
organization – Vessel loading and discharging , liner trade routes, The major ports, liner service options - Liner 
trade – ship types – Tonnages; basic ship layout, types of container ships, Ro-Ro barge carrying vessels, The 
refrigerated cargo ship conventional (Break bulk) vessels future vessel developments, economy of scale, shipboard 
handling equipment. 

II Cargoes & cargo equipment – Dangerous goods IMO special goods, cargo handlings other methods of lifting cargo 
port handling equipment, port terminals; port and terminal management; the role of ships officers - agent. Liner 
Shipping operations - Management and policy, ship management and operations, independent ship management, 
insurance, trade of commercial department, accounting, budgeting, freight collection and port disbursements 
agency duties. 

III Containerization unitization and inter-modalism - Growth in world trade unitization; container dimensions, types 
of container other container expressions container inventory, owning, leasing meeting the demand for containers 
tracking the container fleet, container control, FCLS LCLS & ICDS , legal & insurance implications in the container 
trade. 

IV The Bill of Lading and other Documentation - The Bill of Lading UK bill of lading Act 1855 and UK carriage of goods 
by sea Act 1992, The use of Bill of Lading in liner trades, Bill of Lading documentary credits, Bill of Lading clauses 
The printed clauses – The evidence of the contract, other forms of Bill of Lading other liner documents, Intl 
conventions relating to Bill of Lading, paperless trading 

V The Exchange of goods transfer - Transfer of funds from country to country, methods of payments in International 
trade who are the merchants, International contracts of sale INCO terms; Legal aspects of the liner trades - The 
carrier insurance the carrier’s liability for the cargo the liabilities of the agent, legal aspects of the Bill of Lading, 
cargo claims general average (GA), security, ISPS code. 

Text & Reference Books: 
1. Course Material Prepared by LSC 

2. Ship Operation Management, Fujita, N.H. Publisher, 1974. 

3. Ship Operation Management, Bertrams Publication, 2010. 
 

LINER LOGISTICS 

Semester 

III 
Course Type 

General 
Code 

L21C21 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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COURSE OBJECTIVES: 

This course is designed with the view of making the 
student skilful at 

• Performing data analysis using spreadsheet (MS Excel) 

• Creating pivot tables from a range with rows and columns in 
Excel. 

LEARNING OUTCOMES: 

• Support the E communication effectively with help of Spread 
Sheet 

• Summarize data with data analysis, Pivot Tables, and Pivot 
Charts. 

• Work with charts and the drawing tools. 

• Import and export data from other applications. 

 
Unit Topics 

I Introduction to Excel, About Excel & Microsoft, Uses of Excel, Excel software, Spreadsheet windowpane, Title Bar, 
Menu Bar, Standard Toolbar, Formatting Toolbar, the Ribbon, File Tab and Backstage View, Formula Bar, Workbook 
Window, Status Bar, Task Pane, Workbook & sheets Columns & Rows 

II Selecting Columns & Rows, Changing Column Width & Row Height, Auto fitting Columns & Rows, Hiding /Unhiding 
Columns & Rows, Inserting & Deleting Columns & Rows, Cell, Address of a cell, Components of a cell – Format, 
value, formula, Use of paste and paste special Functionality Using Ranges. Using Ranges, Selecting Ranges, Entering 
Information into a Range, Using AutoFill 

III Creating Formulas, Using Formulas, Formula Functions – Sum, Average, if, Count, max, min, Proper, Upper, Lower, 
Using AutoSum, Advance Formulas Concatenate, Lookup, Lookup, Match, Count if, Text, moving between 
Spreadsheets, Selecting Multiple Spreadsheets, Inserting and Deleting Spreadsheets Renaming Spreadsheets, 
Splitting the Screen, Freezing Panes, Copying and Pasting Data between Spreadsheets, Hiding, Protecting 
worksheets 

IV Creating Charts, Different types of chart, Formatting Chart Objects, Changing the Chart Type, Showing and Hiding 
the Legend, Showing and Hiding the Data Table Data Analysis Sorting, Filter, Text to Column, Data Validation 

V PivotTables, Creating PivotTables, manipulating a PivotTable, Using the PivotTable Toolbar, Changing Data Field, 
Properties, Displaying a PivotChart, Setting PivotTable Options, Adding Subtotals to PivotTables Spreadsheet Tools, 
Making Macros, Recording Macros, Running Macros, Deleting Macros 

Text & Reference Books: 
Microsoft Excel 2016: Comprehensive, Freund, Starks, and Schmieder, Cengage Learning, 2017, ISBN: 9781305870727. 

DATA ANALYSIS USING SPREAD SHEET 

Semester 

IV 
Course Type 

General 
Code 

L21C23 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 



 

49 

 

 

 

 
 
 

 
 

 
 
 
 
 
 
                

 

 

 

                                     BBA-Logistics Management  

                            Syllabus   
                        Semester – IV 

Admitted Batch 2025-26 
 

 
 
 
 



 

50 

 

 

                                                           RETAIL LOGISTICS AND E-COMMERCE 

 
COURSE OBJECTIVES: 

• To develop competencies and knowledge of students to become Retail logistics and E-commerce professionals 

• To orient students in the field of Logistics 

• To help Students to understand Retail logistics and E-commerce 

LEARNING OUTCOMES: 

• Students will be able to apply the basic knowledge of Retail logistics and E-commerce in the real-life situation 

• This subject will enable them to enhance their ability and professional skills in Logistics and E commerce 

 

 
Unit Topics 

I Concept and Scope: Concepts of Retail Logistics and supply chain- Importance of Logistics in these days global 
Sourcing, Dimension of Logistics: Macro and Micro aspects-Supply chain contours: Backward and forward linkages 

II Logistics and Retail Marketing: Logistics as a Support function of Order Fulfilment, Assembling & Labelling from 
Multi-storage points and Delivery- Logistics as an interface of Market forecasting, Stock level management and 
other relevant activities till transportation, preparation for dispatch and outbound documentation and customer 
facilitation tracking out-bound shipments. 

III Reverse Logistics: Basic of reverse logistics - concept, key activities , coordinating with carriers, route map 
optimization, collecting pickup and feedback - Types of reverse logistics –Roles and responsibilities -Best practices 
in reverse logistics 

IV E-Commerce: Introduction to E-commerce logistics including delivery and pickup models and the overall logistic 
setup – Order Processing – Activities in order processing - Types of order processing - - Procedures for generating 
plans and schedules through MIS 

V Types of Ecommerce- B2B-B2C and intra business. Retail Ecommerce – Retailing through internet, Direct 
Online Sales model and its types- Business Models for ecommerce. Electronic Payment system, Electronic CRM 
Applications. E-Security 

Text & Reference Books: 
1. John Fernie & Leigh Sparks ,”Logistics and Retail Management: Emerging Issues and New Challenges in the Retail 

Supply Chain “,Kogan Page 3rd Edition,2009 

2. James B. Ayers & Mary Ann Odegaard , “Retail Supply Chain Management “taylor & francis, 2nd edition 

3. Mr. Gibson G, “Retail Management: Functional Principles & Practices”, Jaico Publishing house, 6th Edition, 2003. 

4. Ray, Supply Chain Management For Retailing, TMH, 2010. 

5. James B. Ayers, Retail Supply Chain Management, Auerbach Publications,2007. 
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COURSE OBJECTIVES: 

• Introduce Multi-modal and Intermodal Transport concepts. 

• Explain Regulatory framework and policies for Multi-modal transportation. 

• Describe Indian Railways’ initiatives to promote Multimodal Logistics in India. 

• Overview evolution of infrastructure facilitating Multi-modal Logistics in India. 

LEARNING OUTCOMES: 

After completing this Course, the student will have the following learnings: 

• The importance and role played by Multi-modal transport in the efficient and cost-effective movement of cargo 

• Types  of  multi-modal  movement  and  the  role  of containerisation for security and speed 

• The provisions and procedures for Exim trade and INCOTERMS 

Indian Government’s policies and vision R for development of seamless multi-modal transport. 

 

U
n
i
t 

Topics 

I Transportation Systems & Multi modal Transport –Concept of Multi modal & Intermodal Transport – introduction to Multi 
modal transport, the difference between Multi modal and Intermodal transport-Type of transport Modes – detail and 
characteristics of air, road, rail, water, pipelines, package carriers-Need, Aim and Key Issues of Multi modal transport. 

II How to organise Multi modal transport-Role of Containerisation in MMT- history, utility, types, ease of handling, cost 
saving-Types of Multi modal transport – combined container transport, rolling Road & forwarding of trailers, RORO & LASH 
transportation-National Multi modal Transport Committee (NMTC) and Logistics Policy of India – key features and importance 

III Multi modal Transportation Act & Procedures-MMTG Act of 1993-Custom procedures for Export & Import - Bill Of Lading – 
Hague Rules, Visby Rules, Hamburg Rules, Voyage by Sea-INCOTERMS – meaning, explanation, list, and types 

IV MMT and Indian Railways-PFT Policy – maintenance of rolling stock, cargo handling, customs, etc-Warehousing Policy – 
stuffing, de-stuffing, stacking, use of MHE, etc-Layout and design of Multi modal Logistics parks 

V Multi modal transport & Practice Today-India’s growing conflict between Trade & transport – issues, policy, problems & 
pricing-Integrated Transport – Bharatmala, Sagarmala, IWT, DFC, the concept of ICP ( International Check Posts-Scenario 
in India and neighbouring countries with a case study 

 

TEXT BOOKS 

1 Course Material Prepared by LSC 

  

 

 
 

 
 
 
 

MULTI-MODAL TRANSPORTATION 

Semester 

IV 
Course Type 

General 
Code 

L21C27C 
Hours 

          60 
Credits 

4 
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2025-26 



 

52 

 

 

 
                                                      

                                                
 

 

COURSE OBJECTIVES: 

• To familiarize the student with the basic concept of the 
most common automations from light to heavy 

• To familiarize the student with the basic concept of the 
supply chain including Logistics, warehousing, IT as well 
as distribution and planning. 

LEARNING OUTCOMES: 
The students will be able to: 
• Recognize the Knowledge of the common and latest 

automation solutions for ware-housing 
• Understand and Recognize the costs and pre-requisites for each 

automation solution and the expected benefits of the different 
solutions 

• Able to complete the analysis and to select the most 
appropriate solution for ware- house automation 

 

Unit Topics 

I Overview of the Traditional Warehouse Operations - Warehouse Automation Systems: Over- view, Applications, 
Costs, Benefits, ROI – Receiving Automation: PalletInverter - Palletizers 

II Storage and Retrieval Automation : Vertical and Horizontal Carrousels - Vertical Lift Module - Orbital Shuttle 
Systems - AS/RS Mini Load - AS/RS Unit Load - Garments on Hangers 

III Material Flow Automation - Conveyors - Lifts - Automated Guided Vehicles - Monorail 

IV Picking/Outbound Automation : Pick / Put To Light - A Frame - Automated Order Selection – Pick-N-Go - Outbound 
Sorters - Automatic Truck Loading . 

V Automating Data Collection : RFID - Automated Measurements Systems - Unique Solution Providers: Kiva Robot 
- Auto Store - Additional Automation Around the Warehouse Building Management System: Weight scales - 
Delivery Drones - Delivery Robots. 

Text & Reference Books: 
1. Course Material Prepared by LSC 
2. Industrial Automation and Robotics: A.K.Gupta and S K Arora 
3. Advanced Industrial Automation and its Application: Ravindra Sharma 

Industrial Control Electronics Devices, Systems, & Applications 3D Edition Author: Terry Bartler Publisher: Delmar 
 

WAREHOUSE AUTOMATION 

Semester 

V 
Course Type 

Domain 
Code 

L21A01A 
Hours 

60 
Credits 

4 
w.e.f 

2025-26 
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IN PLANT LOGISTICS 
 

COURSEOBJECTIVES: 

• To develop competencies and knowledge of students to become In-plant logistics professionals 

• To orient students in the field of Logistics 

• To help Students to understand In-plant logistics operations 

LEARNINGOUTCOMES: 

• Students will be able to apply the Basic knowledge of In-plant operations in the real life situation 

• This subject will enable them to enhance their ability and professional skills 

 

 
Unit Topics 

I Introduction to Logistics in a manufacturing setup - Manufacturing process - physical flow - Assembly line – OTIF 
(on time in full) - Basic activities of in-plant logistics : Loading, Unloading, Receiving, sorting, Storing, Picking and 
dispatch activities - process of coordination with assembly line 

II Job shop- work allocation - Production scheduling – selection of products/ models/parts/ Team table/Time table 
- Material flow – production line –feeding just in time inventory, Vendor management - 

III Inbound logistics- inventory management, importance, Value addition, stock counts, audits 

IV Out bound logistics – Finished goods (FG)- tooling, binding ,creating, input process, output - packaging, Kitting, far 
goods(FH), Spare parts, , After markets process, schedule of transport, vendor coordination 

V Timely supply – scheduling, vendor co ordination quality control, pre delivery Inspection, Quality assurance, on 
time in full (OTIF) 

 

 
 

 

Text & Reference Books: 
1. Course Material Prepared by LSC 
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COURSE OBJECTIVES: 

• To familiarize the student with the basic concept of formalities 
for export trade, and the documentation process required for 
import and export. 

LEARNING OUTCOMES: 

• Recognize the impact of information and communication 
technologies, especially of the internet in business operations. 

• Recognize the fundamental principles of eBusiness and 
eCommerce. 

• Explain the security protocols and the issues in internet 
security. 

 
Unit Topics 

I Introduction to Export and Import 12 Hrs Basics of Exports - Classification of goods - Preparation for Exports 
- Methods of Exporting - Export Marketing Organizations - Functions - Registration formalities IEC Number - 
Procedure of obtaining IEC Number - RCMC (Registration Cum Membership Certificate) –Export Credit Guarantee 
Council (ECGC) - Application for import and export of restricted items. 

II Documentation Framework and Contracts 15 Hrs Aligned Documentation System: Commercial Documents - 
Auxiliary Commercial Documents - Regulatory Documents - Documents related to goods - Documents related to 
Shipment - Documents related to Payments - Documents related to Inspection - Documents related to Excisable 
Goods - Types of Contracts - Export Contracts. 

III Payments and Finance 15 Hrs Factors - Methods of receiving Payment - Instruments of Payments-Letter of Credit 
Pre-shipment Finance - Post-shipment Finance - Post-shipment Credit in Foreign Currency - Negotiation of 
documents with bank - CENVAT - Duty Draw back 

IV Quality Control and Clearance of Cargo 15Hrs Objective of Quality Control - Methods - Procedure for Pre-shipment 
Inspection - Role of Clearing and Forwarding Agents – Role of Inspection Agents-Clearance of Cargo Central Excise 
Clearance Procedure - Central Excise Clearance Option - Shipment of Export Cargo. 

V Customs Clearance, Risk and Insurance Policy 15 Hrs Customs Clearance of Export Cargo - Customs Clearance of 
Import Cargo - Risk: Types - Types of cover issued by ECGC - Cargo Insurance. Processing of an export order - Major 
laws governing export contract. 

Text & Reference Books: 
1. RAMA, GOPAL C. (2008) Export Import Procedures Documentation and Logistics. New Age International Publishers: 

New Delhi. 

2. KHUSHPAT, S. J. (2013) Export Import Procedures and Documentation. Himalaya Publishing House: New Delhi. 

3. PAWAN, KUMAR (2001) Export of India’s Major Products Problems and Prospects. New Century Publications: New 
Delhi. 

4. KAPOOR, D. C. (2002) Export Management. Vikas Publications: New Delhi. 

5. CHERUNILAM, F. (2004) International Trade and Export Management. Himalaya Publications: New Delhi. 

 
Websites: 
1. www.cbec.gov.in/customs/cs-act/cs-act-idx.htm (Central Board of Excise and Customs - Customs Act, 1962, Customs 

Tariff Act – 1975, Other Acts) 

2. www.epckenya.org/(Export Promotion Council) 

3. commerce.nic.in/MOC/index.asp (Ministry of Commerce and Industry) 

4. www.dgft.gov.in/ (Directorate General of Foreign Trade) 

EXPORT AND IMPORT DOCUMENTATION 

Semester 

VI 
Course Type 

Domain 
Code 

L21A02C 
Hours 

60 
Credits 

4 
             W.e.f   

2025-26 

http://www.cbec.gov.in/customs/cs-act/cs-act-idx.htm
http://www.epckenya.org/(Export
http://www.dgft.gov.in/


 

 

 
 

                                        Software Systems in Logistics 
Course Outcomes (COs) 
Course Title: At the end of the course, students will be able to: 
CO1: Explain the role of logistics software systems and their significance in modern supply chains. 
CO2: Demonstrate understanding of ERP systems and their application in logistics management. 
CO3: Analyze the functions of Warehouse Management Systems (WMS) and Transportation Management Systems (TMS) 
in logistics operations. 
CO4: Apply knowledge of digital platforms and software solutions in e-commerce logistics and reverse logistics. 
CO5: Evaluate the impact of emerging technologies such as AI, IoT, Blockchain, and Big Data on logistics and supply chain 
systems. 
 
 

Unit Topics 

I 
Introduction to Logistics Software Systems 
Role of Information Technology in Logistics and Supply Chain Management- Overview of Software Applications in 

Logistics: ERP, WMS, TMS, CRM, SCM software - Importance of automation in warehousing, inventory, 

transportation, and distribution - Case examples of software adoption in logistics industries 

 

II 
Enterprise Resource Planning (ERP) for Logistics 
Concept and features of ERP systems - Modules relevant to logistics: procurement, inventory, distribution, 

finance, HR integration - SAP, Oracle, and Microsoft Dynamics in logistics management - Benefits and challenges 

of ERP implementation in logistics 

 

III 
Transportation and Warehouse Management Systems (TMS & WMS) 
Transportation Management Systems: route planning, fleet management, freight cost optimization - Warehouse 

Management Systems: order processing, picking, packing, cross-docking, barcoding, RFID - Integration of WMS 

and TMS with ERP - Case studies of WMS and TMS applications in logistics companies 

 

IV 
E-Commerce, Reverse Logistics and Digital Tools 
Role of software systems in e-commerce logistics - Last-mile delivery optimization tools and platforms - Reverse 

logistics software: returns, repairs, recycling, and sustainability - Digital logistics platforms and marketplaces 

(Amazon, Flipkart, Maersk, DHL examples) 

 

V 
Emerging Technologies in Logistics Software 
Artificial Intelligence (AI) and Machine Learning in demand forecasting and route optimization - Internet of Things 

(IoT) and sensor-based tracking systems - Blockchain applications in supply chain visibility and security - Cloud 

computing, big data analytics, and future trends in logistics software systems 

 

Suggested References 

1. Bowersox, D.J., Closs, D.J., & Cooper, M.B. – Supply Chain Logistics Management 

2. Sunil Chopra & Peter Meindl – Supply Chain Management: Strategy, Planning and Operation 

3. Simchi-Levi, Kaminsky, & Simchi-Levi – Designing and Managing the Supply Chain 

 
 
 
 
 
 



 

 

 
 
 


